Embed a Data Connected Visio Diagram in SharePoint 2013

Hands-On Lab
Lab Manual
Embed a Data Connected Visio Diagram in SharePoint 2013

Estimated time to complete this lab: **35 minutes**

**Lab Objectives**

In this lab, you will configure an existing Visio diagram to retrieve data from a SharePoint 2013 list, then connect Visio shapes to the list data, and use a custom data-graphic template to present the data on the shapes using text overlays, data bars, and fill colors. You will publish the diagram to SharePoint 2013, and surface it on a web-part page using the Visio Web Access web part.

In addition, you will add interactivity to the page (using web-part connections), then configure and test automatic data refresh. Finally, you will briefly explore collaboration features in Visio Services by adding comments to the diagram.

You will create this data-driven Visio experience without the need to write any programming code or database queries.

After completing this lab, you should be able to:

- Create a Visio data source based on a SharePoint list
- Use the **Automatic Link** feature to relate data-source rows to diagram shapes
- Create a data graphic and apply it to diagram shapes
- Publish the Visio diagram as a Visio Web Diagram to a SharePoint library
- Embed Visio diagrams into a web part page using the **Visio Web Access** web part
- Configure the **Visio Web Access** web part for automatic refresh
- Add comments to a Visio diagram and read others’ replies

**Technologies**

- Visio 2013
- SharePoint 2013

**Audience**

- SharePoint Site Administrators and SharePoint IT Professionals

**Scenario**

This lab takes you through configuring a Visio diagram to retrieve data from a SharePoint 2013 list, customizing the Visio diagram, and then publishing it to SharePoint and interacting with it online.

**Getting Started**

**Connect to the Lab Environment**

Log on to the **DC** virtual machine (VM) as Garth Fort, with the credentials CONTOSO\GarthF, pass@word1.

**Open the Lab Environment**

To begin the lab, open the HOL - Contoso Servers.vsdx Visio file:
1. Switch to the DC virtual machine. Click **Start**, **All Programs**, **Microsoft Office 2013** and then click **Visio 2013**.

2. In Visio 2013, click **Open Other Drawings**.

3. In the Open window, click **Computer**, and then click **Browse**.

4. In the Open dialog box, type `\\W15-SP1\C$\HOLContent\BIHOL-Visio\HOL – Contoso Servers`, and then click **Open**.

   The Visio diagram titled “Contoso Servers” opens with the Shapes window open.
Exercise 1 – Configuring the Data-Driven Visio Diagram

Estimated time to complete this exercise: **10 minutes**

Scenario

Connecting data from external sources, such as Excel, Access, SQL Server or SharePoint, is a two-step process – import your data first, then connect it to shapes.

In this exercise, you will first use the **Data Selector** wizard to import a SharePoint 2013 list into the External Data window in the Visio diagram. The data in the **External Data** window is a snapshot of your source data at the time of import. You can refresh this data to match changes in your source data (click **Refresh All** on the **Data** tab), but Visio doesn’t send changes in the diagram back to the data source.

After importing the SharePoint 2013 list data you will link the rows to Visio shapes. Visio 2013 provides three ways to link rows of data to shapes in your drawing: You can link rows to existing shapes one at a time, you can link the rows to shapes automatically, or you can create shapes from the data. In this exercise you will link the rows to shapes automatically. This requires preparing the shapes beforehand by giving them special Shape Data fields, which has already been completed.

**Task 1 – Importing SharePoint 2013 list data**

In this task, you will import Contoso server data from a SharePoint 2013 list into the External Data window of the Visio diagram.

1. On the **DATA** tab, in the **External Data** group, click **Link Data to Shapes**.
2. In the Data Selector dialog, click the **Microsoft SharePoint Foundation list** radio button, and then click **Next**.

![Data Selector dialog](image)

3. In the **Select a site** dialog, type **http://intranet.contoso.com/sites/BIHOL-Visio** into the **Site** text box, and then click **Next**.
4. If asked for logon information, use the following credentials:

   **User name**: contoso\garthf  
   **Password**: pass@word1

5. In the **Select a list** dialog, click **Contoso Servers**.
6. Click **Link to a list** radio button.
7. Click **Next**.
8. After you click **Finish** on the last page of the Data Selector wizard, the External Data window displays with your imported data shown in a table.

**Task 2 – Automatically Linking Server Data to Visio Server Shapes**

In this task you will use Visio’s **Automatically Link** feature to link the External Data to the Visio diagram shapes. The External Data contains a **Server** column that aligns with the shapes’ **Network Names**. The Server column and Network Name alignment has already been prepared for you.

1. On the **Data** tab, in the **External Data** group, click **Automatically Link**.
2. In the **Automatically link rows to shapes** dialog, click **All shapes on this page** radio button, and then click **Next**.

3. In the next screen, in the **Data Column** drop down, click **Server**.
4. In the **Shape Field** drop down, click **Network Name**, and then click **Next**.

5. After you click **Finish** on the last page of the Automatic Link wizard, Visio links the rows and shapes that have matching values:
   - the Visio diagram displays the appropriate data from the External Data list
   - the External Data list displays a link icon to show the data is linked
6. To view the Shape Data:
   a. Right-click on the **DC-01 shape**.
   b. From the context menu, click **Data**, and then click **Shape Data**.

The Shape Data window displays on the right side of the window.

c. Scroll through the **Shape Data** window and view the data linked to the External Data table.
Task 3 - Applying New Data Graphics to Visio Diagrams

In this task, you will highlight all of the server shapes and use the Data Graphics feature to alter the data field displays and styles.

1. Select all diagram shapes by clicking and holding your left mouse button and dragging a rectangular area across the images.

2. If done correctly, all server images and connectors are selected.
3. On the **Data** tab, in the **Display Data** group, click **Data Graphics**, and then click **Create New Data Graphic**.

4. In the New Data Graphic window, click **New Item**.

5. To configure the item, in the **New Item** window:
   
a. In the **Display** section, from the **Data field** drop down, click **Server**.
   
b. From the **Display as** drop down, click **Text**.
   
   This will populate the Style drop down.
c. From the **Style** drop down, click **Heading 3**.
d. In the **Position** section, uncheck the **Use default position** check box.
e. From the **Horizontal** drop down, click **Center**.
f. From the **Vertical** drop down, click **Above Shape**.
g. In the **Details** section, change **Value Font Size** to **16pt**.
h. When you click OK in the New Item window, the New Data Graphic window will display with the Server Data Field listed.

![New Data Graphic Window](image)

6. To add the **Bandwidth Used (GB)** as the next new data field:

   a. In the New Data Graphic window, click **New Item**.
   b. In the New Item window, make the following selections, and then click **OK**.

<table>
<thead>
<tr>
<th>Property</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data Field</td>
<td>Bandwidth Used (GB)</td>
</tr>
<tr>
<td>Displayed As</td>
<td>Data Bar</td>
</tr>
<tr>
<td>Style</td>
<td>Progress Bar</td>
</tr>
<tr>
<td>Use Default Position</td>
<td>Deselect</td>
</tr>
<tr>
<td>Horizontal</td>
<td>Center</td>
</tr>
<tr>
<td>Vertical</td>
<td>Below Shape</td>
</tr>
<tr>
<td>Details – Value Font Size</td>
<td>8pt.</td>
</tr>
</tbody>
</table>

7. To add the **Admin** as the next new data field:

   a. In the New Data Graphic window, click **New Item**.
   b. In the New Item window, make the following selections and then click **OK**.

<table>
<thead>
<tr>
<th>Property</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data Field</td>
<td>Admin</td>
</tr>
<tr>
<td>Displayed As</td>
<td>Text</td>
</tr>
<tr>
<td>Style</td>
<td>Text callout</td>
</tr>
</tbody>
</table>
8. To add the **Status** as the next new data field:

   a. In the New Data Graphic window, click **New Item**.
   b. In the New Item window, make the following selections and then click **OK**.

<table>
<thead>
<tr>
<th>Property</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data Field</td>
<td>Status</td>
</tr>
<tr>
<td>Displayed As</td>
<td>Color by Value</td>
</tr>
<tr>
<td>Coloring method</td>
<td>Each color represents a unique value</td>
</tr>
<tr>
<td>Color Assignments</td>
<td>Red = Offline, Green = Online</td>
</tr>
</tbody>
</table>

![](image)
9. Confirm the final New Data Graphic window looks as follows, and then click **OK**.

![New Data Graphic Window](image)

**Data Field**
- **Server**: Text, Center, Above Shape
- **Bandwidth Used (GB)**: Data Bar, Center, Below Shape
- **Admin**: Text, Center, Below Shape

**Status**
- **Color by Value**

**Default position**
- **Horizontal**: Far Right
- **Vertical**: Middle

**Display options**
- Show border around items at default position
- Hide shape text when data graphic is applied

10. If prompted, click **Yes** to apply this data graphic to the selected shapes.

![New Data Graphic Confirmation Window](image)
The final report should look as follows:

**Task 4 – Publishing the Visio Diagram**

In this task, you will save the Visio diagram to a SharePoint 2013 document library. Then you will open and interact with the Visio diagram in SharePoint.

First, you will save the Visio diagram to the BIHOL-Visio site in SharePoint 2013.

1. In Visio 2013, on the **File** tab, click **Save As**.
2. In the Save As window, click **Computer**, and then click **Browse**.
3. In the Save As dialog box, navigate to http://intranet.contoso.com/sites/BIHOL-Visio

4. If asked for log in information, enter the following credentials:
   - User name: contoso\garthf
   - Password: pass@word1

5. Under Document Libraries, double-click Documents to open the library, and then click Save.

In this exercise, you imported a SharePoint 2013 list of Contoso Server data. You then used the Automatically Link feature to link the imported server data to the server shapes in the Visio diagram. You then applied new data graphics to the Visio diagram, and then published the Visio diagram to a SharePoint 2013 library.

**Exercise 2 : Embedding Visio Diagrams in a Web-Part Page**

**Scenario**

In this exercise, you will create a web-part page named Contoso Diagrams. You will then configure the page to contain the Visio Web Drawings library web part and a Visio Web Access web part. A connection will be defined to pass the selected Visio diagram to the Visio Web Access web part.

To experience the automatic refresh capabilities of the Visio Web Access web part, you will change the status for a server, then see the Visio diagram update to reflect the change.
Task 1 – Adding Visio Web Access web part to a web part page

In this task, you will add a Visio Web Access web part to a web part page and then you will add the Documents web part to drive displaying the Contoso Server data in the Visio Web Access web part.

2. If prompted for login information, enter the following credentials:
   **User name**: contoso\garthf
   **Password**: pass@word1
3. On the BIHOL-Visio page, in the left navigation, click Contoso Server Status to open the page.
4. From the Settings menu, click **Edit page**.
5. If a **Message from webpage** dialog box displays, click **OK** to check out the item before making changes.
6. In the **Header** web part zone, click **Add a Web Part** link.

7. Under Categories, click **Business Data**, then click **Visio Web Access** under Parts:

8. Click **Add** to add the Visio Web Access web part to the page.
9. Click the Click here to open the tool pane link to configure the Visio Web Access web part.

![Select a Web Drawing](image)

10. To configure the Visio Web Access:
   a. In the **Automatic Refresh** Interval text box, enter 1.
   b. Deselect the **Show Page Navigation** checkbox.
   c. Expand **Appearance** section, and then change **Title** to **Visio Diagrams**.
   d. Set Height to **600 Pixels**.
   e. Click **OK**.

*Note:* The **Web Drawing URL** property will not be configured yet. The web part will pull the URL information from the Visio diagrams in the Documents library.
Task 2 – Connecting the Visio Web Access library to the Documents library

You will now add the Documents library web part to pass in the user-selected diagram to the Visio Diagrams web part property.

1. To add the Documents library as a second web part:
   a. In the Header web part zone of the page, click Add a Web Part.
   b. From the Categories list, click Apps and from the Parts list, click Documents.
   c. Click Add to add the Documents library web part to the page.

2. To Connect the Visio Web Access web part to the Documents library web part:
   a. Click the drop-down arrow in the top right corner of the Visio Web Access Web Part.
   b. Click Connections.
   c. Click Get Web Drawing URL and Page Name From.
d. Click **Documents**.

The Configure Connection – Webpage Dialog displays.

```
Provider Field Name: Created
Consumer Field Name: 
```

```
Finish  Cancel
```

e. In the **Configure Connection Webpage Dialog**, from the **Provider Field Name** drop down, click **Document URL**.
f. From the **Consumer Field Name** drop down, click **Web Drawing URL**, and then click **Finish**.

The selected Visio diagram displays in the Visio Diagrams web part.

3. On the **Format Text** tab, in the **Edit** group, click **Save** to save the changes and stop editing the page, so you can interact with the web parts.
4. To view another Visio diagram listed in the Documents library web part, click on the double arrow diagonal adjacent to the desired .VSDX file and your selection populates the lower web part.

   **Note:** If you click the document names, the Visio diagrams will open in a new window.

---

**Task 3 – Interacting with the Visio Diagrams**

1. In Documents web part, click the double-arrow beside **HOL - Contoso Servers**.
2. In the lower right corner of Visio Diagram web part, use the Zoom feature to zoom in and zoom out of the image.

5. Click **Zoom to fit page to view**.

6. In the Visio Diagrams web part, click the diagram and while holding down the mouse button, move the diagram around the web part.
7. In the Visio Web Access, click the **DC-01 server image**, and then click **Shape Info** to display the server information.

8. Scroll down in the Shape Info dialog and note the Server data.

---

**Task 4 - Changing Server Information in a Visio Diagram**

In this task you will open the list of Contoso Servers, change the data for the Email Server, save the information, and then view the change on the Contoso Server Status web part page.
1. In the left navigation, right-click Contoso Servers, and then click Open in new tab.

2. Click on the ContosoServers-All Items tab to display the list.

3. In the ContosoServers list, click to select the EMAIL-03 item.
4. To change the Bandwidth Used:
   a. Click the ellipse beside EMAIL-03 to open the menu, and then click **Edit Item**.

   ![Image of server details](image1)

   b. In the EMAIL-03 Edit window, in the **Bandwidth Used (GB)** text box change 65 to **100**.

   ![Image of edit window](image2)

   c. Click **Save**.

5. To view the changes:
   a. Click **Pages – Contoso Server Status** tab to return to the **Contoso Server Status** page.
b. On the Contoso Server Status page, in the Visio Diagrams web part, click Refresh to update the data.  
**Note:** You may need to click Refresh several times until you see EMAIL-03 updated to 100.

![Visio Diagram](image)

b. On the Contoso Server Status page, in the Visio Diagrams web part, click Refresh to update the data.  
**Note:** You may need to click Refresh several times until you see EMAIL-03 updated to 100.

![Visio Diagram](image)

**c.** Note the Bandwidth used for EMAIL – 03 is now 100.

![Visio Diagram](image)

**Task 5 – Leaving and Responding to Comments on a Visio Diagram**

1. In the Documents web part, click the **Contoso Sales Process** name to open the Visio diagram in Visio Services full screen mode.
2. In the new window, click the **Shipping** shape and in the top navigation, click **Comments**.

![Comments window](image)

A **Comments** window opens on the right side of the page.

3. In the **Comments** section, click **New**.
4. Type the following message in the text box.
   
   **We need to add a step for fulfillment process.**

5. Click the white space below the new text box to add the comment.
   
   Note the comment icon above the **Shipping** shape.

![Visio diagram](image)

**Note:** You can also click in the **Reply** text box to respond to an existing comment.

In this exercise, you added a Visio Web Access web part and a Documents library web part to a web part page. You then used Connections to the two web parts so that when a Visio diagram is selected in the Documents library web part, the Visio diagram will display in the Visio Web Access web part. You then interacted with the web part page in SharePoint. And finally, you added comments to the Visio diagram in SharePoint 2013.
Summary

In this lab you investigated the Visio 2013 and SharePoint 2013 integration features. You learned how to pull in data from a SharePoint 2013 list into a Visio diagram, how to save the Visio file to SharePoint and how to create a web part page to display Visio diagrams.

This lab discussed how to perform the following tasks:

- Create a Visio data source based on a SharePoint list
- Use the **Automatic Link** feature to relate data-source rows to diagram shapes
- Create a data graphic and apply it to diagram shapes
- Publish the Visio diagram as a Visio Web Diagram to a SharePoint library
- Embed Visio diagrams into a web part page using the **Visio Web Access** web part
- Configure the **Visio Web Access** web part for automatic refresh
- Add comments to a Visio diagram and read others' replies